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Troubleshooting Utility.
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Using Help
Conventions
Navigating Help
Searching Help
Printing Help File Topics

Conventions
This help file uses the following formatting and typographical
conventions:
»

The » symbol leads you through nested menu items and
dialog box options to a final action. The sequence
File»Page Setup»Options directs you to pull down the File
menu, select the Page Setup item, and select Options from
the last dialog box.
This icon denotes a note, which alerts you to important
information.

bold

Bold text denotes items that you must select or click in the
software, such as menu items and dialog box options. Bold
text also denotes parameter names.

green

Underlined text in this color denotes a link to a help topic,
help file, or Web address.

italic

Italic text denotes variables, emphasis, cross references, or
an introduction to a key concept. Italic text also denotes text
that is a placeholder for a word or value that you must
supply.

monospace Text in this font denotes text or characters that you should
enter from the keyboard, sections of code, programming
examples, and syntax examples. This font is also used for
the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions.
monospace Bold text in this font denotes the messages and responses
bold
that the computer automatically prints to the screen. This
font also emphasizes lines of code that are different from the
other examples.
monospace Italic text in this font denotes text that is a placeholder for a
italic
word or value that you must supply.

Navigating Help (Windows Only)
To navigate this help file, use the Contents, Index, and Search tabs to
the left of this window or use the following toolbar buttons located above
the tabs:
Hide—Hides the navigation pane from view.
Locate—Locates the currently displayed topic in the Contents tab,
allowing you to view related topics.
Back—Displays the previously viewed topic.
Forward—Displays the topic you viewed before clicking the Back
button.
Options—Displays a list of commands and viewing options for the
help file.

Searching Help (Windows Only)
Use the Search tab to the left of this window to locate content in this help
file. If you want to search for words in a certain order, such as "related
documentation," add quotation marks around the search words as shown
in the example. Searching for terms on the Search tab allows you to
quickly locate specific information and information in topics that are not
included on the Contents tab.

Wildcards
You also can search using asterisk (*) or question mark (?) wildcards.
Use the asterisk wildcard to return topics that contain a certain string. For
example, a search for "prog*" lists topics that contain the words
"program," "programmatically," "progress," and so on.
Use the question mark wildcard as a substitute for a single character in a
search term. For example, "?ext" lists topics that contain the words
"next," "text," and so on.
Note Wildcard searching will not work on Simplified Chinese,
Traditional Chinese, Japanese, and Korean systems.

Nested Expressions
Use nested expressions to combine searches to further refine a search.
You can use Boolean expressions and wildcards in a nested expression.
For example, "example AND (program OR VI)" lists topics that contain
"example program" or "example VI." You cannot nest expressions more
than five levels.

Boolean Expressions
Click the button to add Boolean expressions to a search. The following
Boolean operators are available:
AND (default)—Returns topics that contain both search terms. You
do not need to specify this operator unless you are using nested
expressions.
OR—Returns topics that contain either the first or second term.
NOT—Returns topics that contain the first term without the second
term.
NEAR—Returns topics that contain both terms within eight words
of each other.

Search Options
Use the following checkboxes on the Search tab to customize a search:
Search previous results—Narrows the results from a search that
returned too many topics. You must remove the checkmark from
this checkbox to search all topics.
Match similar words—Broadens a search to return topics that
contain words similar to the search terms. For example, a search
for "program" lists topics that include the words "programs,"
"programming," and so on.
Search titles only—Searches only in the titles of topics.

Printing Help File Topics (Windows Only)
Complete the following steps to print an entire book from the Contents
tab:
1. Right-click the book.
2. Select Print from the shortcut menu to display the Print Topics
dialog box.
3. Select the Print the selected heading and all subtopics option.
Note Select Print the selected topic if you want to print
the single topic you have selected in the Contents tab.
4. Click the OK button.

Printing PDF Documents
This help file may contain links to PDF documents. To print PDF
documents, click the print button located on the Adobe Acrobat Viewer
toolbar.

Unknown NI-488.2 Software Error
An unknown NI-488.2 software problem has occurred. Try the following
to resolve the problem before calling National Instruments:
1. Restart your system.
2. Run the NI-488.2 Troubleshooting Utility again.
If you still have the problem, try the following:
1. Reinstall NI-488.2 for Windows.
2. Restart your system.
3. Run the NI-488.2 Troubleshooting Utility again.

Determining Resource Conflicts
Use the Windows Device Manager to determine which resources have a
conflict.

1.
2.

3.
4.
5.
6.

Click this button accesses the
Device Manager.
Select the device that has the resource conflict and click the
Properties button. A yellow exclamation point (!) indicates the
device with the resource conflict.
Select the Resources tab and click the Set Configuration
Manually button.
View the conflicting resource information to determine which
resource conflicts with which device.
Click OK when you are finished.
In the System Settings Change dialog, click Yes to restart the
computer or No if you want to restart the computer later.

Address Resource Conflict
This error occurs if the address resources assigned to a GPIB interface
conflict with the address resources being used by other devices in the
system.
Typically, resource conflicts occur when your system contains hardware
that is configured to use the same resources as your GPIB interface.
Resource conflicts are detected by NI-488.2 when the driver is loaded. If
there is a resource conflict, the driver fails to load and records an error in
the Event Viewer describing why it failed to load.
Determine the resource that caused the conflict and select new
resources that are not in conflict.
Use the Windows System Information tool to get a list of the resource
usage that is known to the operating system. This utility displays a list of
I/O addresses, interrupt levels, and DMA channels that are currently in
use.
Once you know what resources are in conflict, run the Windows Device
Manager utility to configure the new conflict-free resources.

Click here to access the Windows
Device Manager.

Interrupt Resource Conflict
This error occurs if the interrupt resource assigned to a GPIB interface
conflicts with the interrupt resource being used by another device in the
system.
Typically, resource conflicts occur when your system contains hardware
that is configured to use the same resources as your GPIB interface.
Resource conflicts are detected by NI-488.2 when the driver is loaded. If
there is a resource conflict, the driver fails to load and records an error in
the Event Viewer describing why it failed to load.
Determine the resource that caused the conflict and select new
resources that are not in conflict.
Use the Windows System Information tool to get a list of the resource
usage that is known to the operating system. This utility displays a list of
I/O addresses, interrupt levels, and DMA channels that are currently in
use.
Once you know what resources are in conflict, run the Windows Device
Manager utility to configure the new conflict-free resources.

Click here to access the Windows
Device Manager.

DMA Resource Conflict
This error occurs if the DMA resource assigned to a GPIB interface
conflicts with the DMA resource being used by another device in the
system.
Typically, resource conflicts occur when your system contains hardware
that is configured to use the same resources as your GPIB interface.
Resource conflicts are detected by NI-488.2 when the driver is loaded. If
there is a resource conflict, the driver fails to load and records an error in
the Event Viewer describing why it failed to load.
Determine the resource that caused the conflict and select new
resources that are not in conflict.
Use the Windows System Information tool to get a list of the resource
usage that is known to the operating system. This utility displays a list of
I/O addresses, interrupt levels, and DMA channels that are currently in
use.
Once you know what resources are in conflict, run the Windows Device
Manager utility to configure the new conflict-free resources.

Click here to access the Windows
Device Manager.

Event Viewer
The Event Viewer is used to maintain a system log. If the NI-488.2 driver
fails to start properly, it records entries in the system log that explain why
it failed to start.
Follow these steps to use the Event Viewer:

1.
2.

3.

4.
5.

6.

Click here to access the Event
Viewer.
From the left window pane, select System Log if you are running
Windows 2000. For Windows XP, this option is called System.
For Windows Vista, expand Windows Logs and select System.
For Windows 2000/XP, select the View menu and make sure All
Records and Newest First are selected. For Windows Vista,
select the View menu and make sure Sort By Date and Time is
selected.
Begin examining the event details from the top of the list. To view
event details, double-click on the event.
The events of interest are those with the word gpib in the Source
column. You are looking for GPIB-related events that mention a
resource conflict. You can ignore all other GPIB-related events.
Note the very first resource conflict encountered. You need to
know the type of resource conflict, for example, I/O address, IRQ,
or DMA. You also need to know which board the conflict is for; for
example, board #0 means that there is a conflict with GPIB0.
Note Be careful not to look past the last event logged since the
system started. The event whose Source is EventLog with a
description of The Event log service was started is the first event
logged when the system starts up.

One or More Missing GPIB Interfaces
NI-488.2 did not recognize every GPIB interface. There are several
reasons why you might encounter this problem:

GPIB interface is not properly installed
Refer to the GPIB Hardware Guide to verify that your GPIB interface is
correctly installed. Rerun the NI-488.2 Troubleshooting Utility.

Click here to open the GPIB Hardware
Guide.

GPIB interface is not properly configured
If Windows or NI-488.2 cannot configure the hardware, it is listed in the
Device Manager with a yellow exclamation icon. Select the
malfunctioning device and uninstall it. Then refresh the Device Manager
to reattempt configuration.

Click here to access the Device
Manager.

Windows has not finished installing the hardware
Complete the Found New Hardware Wizard for each GPIB interface. If
you canceled the Found New Hardware Wizard, reboot your system and
make sure the wizard finishes adding the GPIB hardware.

GPIB-ENET/100 has not been added to the system
You must run the Add GPIB-ENET/100 Wizard before using your
interface. The wizard guides you through the process of adding a GPIBENET/100.

Click here to run the Add GPIBENET/100 Wizard.

GPIB interface has been removed from the system
You have removed the GPIB interface from the system. For Plug-andPlay GPIB interfaces, click on the link below to launch the Device
Manager. Right-click on your computer's name in the list and select Scan
for hardware changes. You may also reboot your computer to allow the
operating system to detect and install your GPIB interface. For the GPIBENET/100, rerun the Add GPIB-ENET/100 wizard.

Click here to access the Device
Manager.

Click here to run the Add GPIBENET/100 Wizard.

Unknown Hardware Error
An unknown GPIB hardware error has been encountered. The basic
problem is that your hardware is not being correctly recognized by the
system. Several of the possible causes for this problem are listed below:

The NI-488.2 driver for your GPIB interface failed to load
correctly due to a resource conflict
Typically, resource conflicts occur when your system contains hardware
that is configured to use the same resources as your GPIB interface.
Resource conflicts are detected by NI-488.2 when the driver is loaded. If
there is a resource conflict, the driver fails to load and records an error in
the Event Viewer describing why it failed to load.
Use the Windows System Information tool to get a list of the resource
usage that is known to the operating system. This utility displays a list of
I/O addresses, interrupt levels, and DMA channels that are currently in
use.
Once you know what resources are in conflict, run the Windows Device
Manager utility to configure the new conflict-free resources.

Click here to access the Windows
Device Manager.

Your GPIB interface is incorrectly installed or configured
Verify that your GPIB interface is correctly installed and configured. For
information about the installation and configuration of your GPIB
hardware, refer to the GPIB Hardware Guide.

Click here to open the GPIB Hardware
Guide.

Your GPIB interface appears to be installed correctly and
working properly, but the NI-488.2 Troubleshooting Utility
still reports this error
Try restarting your computer and rerunning the NI-488.2 Troubleshooting
Utility. If problems persist, contact National Instruments for more help.

Hardware Error: Incorrect ENET/100 Firmware
Version
The firmware revision on the GPIB-ENET/100 is incorrect. To upgrade
the firmware, use the Firmware Update utility. The latest GPIB-ENET/100
firmware image can be found through the Technical Support section of
ni.com.
To launch the utility, follow these steps:

1.

Click here to start
Measurement & Automation Explorer.
2. Open Devices and Interfaces.
3. Right-click on any GPIB-ENET/100 interface and select Update
Firmware from the menu.

Missing IP Address ENET/100
The GPIB-ENET/100 is not powered on and ready to operate, or the IP
address is either unspecified or incorrectly specified. Follow these steps
to resolve the problem:
1. Ensure that the GPIB-ENET/100 is powered on. The PWR/RDY
LED should be steady yellow or orange.
2. Go to Start»Settings»Control Panel»Network and Dial-up
Connections. Verify that there is a Local Area Connection and it
is enabled. Right-click on the Local Area Connection and select
Properties. Ensure that TCP/IP is listed and selected in the Local
Area Connection properties.
3. Verify that the GPIB-ENET/100 has been properly assigned an IP
address or hostname by doing the following:

a.

Click here to start the NI
Ethernet Device Configuration utility.
b. Look for the GPIB-ENET/100 interface you want to
configure on the list of network devices. You can identify
your interface by its serial number or Ethernet address
printed on the baseplate label.
c. Record the IP address or hostname of your interface from
the IP address/hostname field. If there was an error, or the
interface shows up as unconfigured, refer to the GPIB
Hardware Guide for instructions on configuring the
interface.

Click here to open the

GPIB Hardware Guide.
d. The NI Ethernet Device Configuration utility can discover
your GPIB-ENET/100 only if it is on the same subnet as
the computer running the utility. If you cannot determine
the IP address using the NI Ethernet Device Configuration
utility, contact your network administrator.
4. Verify that the IP address is set correctly for your GPIB interface.

a.

Click here to start
Measurement & Automation Explorer.
b. Under Measurement & Automation Explorer, expand the
Devices and Interfaces folder. Look for the GPIB
interface you want to configure on the list of network
devices.
c. Click on the interface name and view the GPIB interface
properties.
d. Verify that the IP Address field matches the IP address or
hostname from step 3.
5. Verify that the GPIB-ENET/100 is correctly configured for your
network. The easiest way to do this is to use a network utility
called ping. Open a command window and type in the following
command:
ping <IPaddress>
where <IPaddress> is the IP address assigned to your GPIBENET/100 in step 3. If you are accessing a GPIB-ENET/100 via a
hostname, type in the following command instead:
ping <hostname>
If the ping utility is unable to communicate with the GPIBENET/100, verify your IP address/hostname with your network
administrator.
6. If these steps do not resolve the issue, delete the GPIB-

ENET/100 interface from MAX and run the Add GPIB-ENET/100
wizard again.

7.

Click here to run the Add GPIBENET/100 Wizard.

Launch Ethernet Device Configuration Utility
Use the NI Ethernet Device Configuration utility if you need to manually
configure the network parameters of the GPIB-ENET/100. If your network
uses DHCP, the network configuration is performed automatically at
startup and you do not need to run this utility unless you want to change
the hostname. Consult your network administrator if you do not know
whether your network uses DHCP.

Click here to start the NI Ethernet
Device Configuration utility.
Refer to the GPIB Hardware Guide for information about using the utility
to configure the network settings for your GPIB-ENET/100.

Click here to open the GPIB Hardware
Guide.

Important Information
Warranty
Copyright
Trademarks
Patents
Warning Regarding Use of NI Products

Warranty
The GPIB hardware is warranted against defects in materials and
workmanship for a period of one year from the date of shipment, as
evidenced by receipts or other documentation. National Instruments will,
at its option, repair or replace equipment that proves to be defective
during the warranty period. This warranty includes parts and labor.
The media on which you receive National Instruments software are
warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of
shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice
of such defects during the warranty period. National Instruments does not
warrant that the operation of the software shall be uninterrupted or error
free.
A Return Material Authorization (RMA) number must be obtained from
the factory and clearly marked on the outside of the package before any
equipment will be accepted for warranty work. National Instruments will
pay the shipping costs of returning to the owner parts which are covered
by warranty.
National Instruments believes that the information in this document is
accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist,
National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition.
The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising
out of or related to this document or the information contained in it.
EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES
NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY
DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. CUSTOMER'S RIGHT TO RECOVER
DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING

FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF
THE POSSIBILITY THEREOF. This limitation of the liability of National
Instruments will apply regardless of the form of action, whether in
contract or tort, including negligence. Any action against National
Instruments must be brought within one year after the cause of action
accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty
provided herein does not cover damages, defects, malfunctions, or
service failures caused by owner's failure to follow the National
Instruments installation, operation, or maintenance instructions; owner's
modification of the product; owner's abuse, misuse, or negligent acts;
and power failure or surges, fire, flood, accident, actions of third parties,
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or
transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in
whole or in part, without the prior written consent of National Instruments
Corporation.
National Instruments respects the intellectual property of others, and we
ask our users to do the same. NI software is protected by copyright and
other intellectual property laws. Where NI software may be used to
reproduce software or other materials belonging to others, you may use
NI software only to reproduce materials that you may reproduce in
accordance with the terms of any applicable license or other legal
restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of
National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks.
FireWire® is the registered trademark of Apple Computer, Inc.
Handle Graphics®, MATLAB®, Real-Time Workshop®, Simulink®,
Stateflow®, and xPC TargetBox® are registered trademarks, and
TargetBox™ and Target Language Compiler™ are trademarks of The
MathWorks, Inc.
Tektronix® and Tek are registered trademarks of Tektronix, Inc.
Other product and company names mentioned herein are trademarks or
trade names of their respective companies.
Members of the National Instruments Alliance Partner Program are
business entities independent from National Instruments and have no
agency, partnership, or joint-venture relationship with National
Instruments.

Patents
For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents.txt file on
your CD, or ni.com/patents.

Technical Support and Professional Services
Visit the following sections of the award-winning National Instruments
Web site at ni.com for technical support and professional services:
Support—Technical support resources at ni.com/support include the
following:
Self-Help Resources—For answers and solutions, visit
ni.com/support for software drivers and updates, a searchable
KnowledgeBase, product manuals, step-by-step
troubleshooting wizards, thousands of example programs,
tutorials, application notes, instrument drivers, and so on.
Registered users also receive access to the NI Discussion
Forums at ni.com/forums. NI Applications Engineers make
sure every question submitted online receives an answer.
Standard Service Program Membership—This program
entitles members to direct access to NI Applications
Engineers via phone and email for one-to-one technical
support, as well as exclusive access to on demand training
modules via the Services Resource Center. NI offers
complementary membership for a full year after purchase,
after which you may renew to continue your benefits.
For information about other technical support options in your
area, visit ni.com/services or contact your local office at
ni.com/contact.
Training and Certification—Visit ni.com/training for self-paced
training, eLearning virtual classrooms, interactive CDs, and
Certification program information. You also can register for
instructor-led, hands-on courses at locations around the world.
System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, National
Instruments Alliance Partner members can help. To learn more,
call your local NI office or visit ni.com/alliance.
If you searched ni.com and could not find the answers you need, contact
your local office or NI corporate headquarters. You also can visit the
Worldwide Offices section of ni.com/niglobal to access the branch office
Web sites, which provide up-to-date contact information, support phone
numbers, email addresses, and current events.

Windows System Information Tool
The Windows System Information Tool collects and displays your system
configuration information. Use this tool to determine which resources in
the system are currently in use. The information provided by this utility is
a useful guide for selecting conflict-free resources.
The Windows System Information tool has been started for you. Follow
these steps to use it:

1.

Click here to access the

System Information Tool.
2. Select Hardware Resources from the left window pane.
3. Use the IRQs, I/O and DMA folders to view in-use resources.
4. When you are finished, click the x in the top right corner to exit the
System Information utility.
Use System Information to find free resources. For example, if you are
experiencing an interrupt resource conflict, view the IRQ resources that
are being used and determine which are available. Note an available IRQ
resource and then use the Windows Device Manager utility to configure
NI-488.2 to use that available IRQ resource for the GPIB interface. Make
sure to modify the GPIB hardware settings to match the new resources if
your GPIB interface is not a Plug-and-Play interface (for example, an ATGPIB/TNT).
For more information about configuring a non-Plug-and-Play GPIB
interface, refer to the GPIB Hardware Guide.

Click here to open the GPIB Hardware

Guide.

Click here to access the Windows
Device Manager.
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